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Introduction 

Premier Pro is a non-linier, non-destructive online video editing system manufactured by Adobe 

Editing is done by importing into Premier a copy of all materials which you want to use. 

These materials are called assets, and can be video clips, animations, still images or sound files. 

Along with materials created within the program, are stored in an asset library (or Project window 

for Premier). 

The materials are put together in a temporal order on a Time line. 

The time line and references to the assets are collected into a Project, and saved as a .prproj file. 

You are able to view your edit in a monitor panel. 

Asset libraries, timelines and monitor panels are standard across most video editing software, so 

once you have the grasped concept you have a good chance of using other editing software like Final 

Cut. 

 

In this short course we will cover the importing of assets, but not the capturing directly from a 

camera as this is far less common these days. We will edit together a short clip and then export it. 

This is a basic edit. Next we will add transitions and titles. 

Finally we will look at effects and different forms of export. 

 

 

 



 

Importing Assets 

Create the Project 

In versions of Adobe Premier Pro produced since 2003, you are required to create the Project before 

anything else. 

This will require you to specify the format, and location of the Project.  

Step 1: Open the software. 

Step 2: Choose New Project (if you are opening a recently used Project you may find it available, 

otherwise navigate to it after choosing Open Project). 

Step 3: Nominate the location and name of your Project. For this example, use the C:\temp 

directory, and possibly create a new sub-directory. 

Step 4: select either a Preset format, or use Custom Settings to specify the settings. The settings 

cover the frame width and height (measured in pixels), the frame rate (measured in Frames per 

second or fps) and the audio quality (measured in Hertz). 

Note: you should base your Project settings upon the format of video clips you will be editing. You 

can find the details of what these are by using a file manager like Windows Explorer or by opening 

the file in playback software and finding the settings. 

You typically set these options on your camera when filming. 

PAL is the Australian video standard, and it’s settings are 720h x 576v at 25 fps. 

High Definition is either 1280h x 720v or 1440h x 1080v 

Also to be checked is the pixel aspect ratio. Computer monitors use square pixels, but CRT television 

screens do not. If you plan on playing back through a CRT television, or your camera has filmed this 

way, then set the project accordingly. 

Step 5: Select the Preset DV-PAL > Standard 32kHz, then in the Custom Settings tab change the 

Fields to No Fields (Progressing Scan) 

Step 6: For Location use the Browse button to navigate and create a new folder on the C:\ drive of 

the computer. 

Note: Video files are very large. You want to use the fastest drive available to you, which is typically a 

hard drive on your computer. An external drive or a USB memory stick are not you fastest options 

and may result in the project crashing or the output being corrupted. 

Step 7: Name your project 

You now see the Adobe Premier interface 



 

 

Premier interface  

In the top left corner is your Asset library, called the Project Window. This is named after the Project. 

Next to it in the top centre is an effects panel. In the top right is your monitor. 

The bottom of the screen is the Timeline. 

To the bottom right you will see a small audio level meter and your tools 

You can rearrange these panels, and when comfortable you may want to save the rearranged 

version (Window > Workspace > New Workspace), or you can reset the panels (Window > 

Workspace > Reset current Workspace). 

Some panels have tabs offering access to additional content. You can access all panels from the 

Window drop down menu. 

Importing footage 

You can drag footage from a file manager (eg Windows Explorer) into the Library, or you can use 

Premier with the commands File > Import or Ctrl I or by right mouse button clicking in the Library 

and choosing Import. 

Note: there is a file already in the library called Sequence 01. That is a representation of your 

Timeline. If you delete it you will lose your timeline and any edits you have made on it.  



Once you have footage in your library you can organise it into folders. Clicking on an item to select it 

will: 

Give you details of the item in the upper part of the library window, and 

Bring the Source window to the front on the effects panel. 

Step 1: Create a directory on the C:\ drive and copy the course supplied resource files to it. 

Step 2: Using one of the methods described above, Import the footage into a new Project. 

CODECs  

One of the biggest issues that you may encounter is CODEC compatibility. 

A CODEC or Coder / DeCoder is a software algorithm which is used to compress video footage. 

Almost no footage created by your video camera is not compressed to some degree. The camera will 

understand how to play back the footage as it will be able to encrypt and unencrypt with the correct 

CoDec. It is possible that the footage from your camera may not be understood by the video editing 

software. The best first step is to install and software that came with your camera as this will give 

the computer and the editing software access to the CoDecs. If this is still unsuccessful then you 

need to find the name of the CoDec so that you can search for it and install it. There are bundles of 

CoDecs that you can install which will install which should be a good catch all. Adobe Premier does 

come with a range of CoDecs already installed, so in theory you will not encounter this issue.



 

Editing 

All editing is dome in the Timeline. 

You simply drag the assets that you wish to edit onto the Timeline, Trim and Cut as appropriate and 

move the clips as you require. 

If necessary, you can drag the same clip into the time line twice. 

Timeline features 

All the real work is done in the Timeline. 

The Horizontal axis is a measurement of time , displayed as Hours:Minutes:Seconds:Frames. You are 

able to zoom in on this axis. 

The vertical axis shows the number if tracks available. By default a sequence is created with three 

Video and three Audio tracks. These can be added to or removed as required. To add a track either 

drop the new clip into the darker grey area above or below the existing tracks, or use Sequence > 

Add Tracks and follow the prompts. Note that you can also delete tracks using Sequence > Delete 

tracks. 

The red marker indicates the current point on the time line which you are at. 

You can drag the play head back and forth, with the mouse. 

Note: the left and right Cursor buttons will move the play head forward or backward one frame at a 

time. Page Up and Page Down will move to the next or previous clip, and Home and End move to 

the beginning and end of the sequence. 

 

Video tracks read from the bottom up, so a clip on Video track 2 will be visible over a clip on video 

track 1. All audio will play at the same time. 

 You are able to adjust the transparency of a video track, and you can adjust the volume of individual 

audio trace, as well as the overall (Master) volume. 



To change the Video transparency, click and drag the yellow line the runs the length of the individual 

clips. You cannot drag it above 100% Opacity. You can drag it down to 0% which would be 

completely transparent. Notice that each clip by default has a drop down option at the top right 

which indicates what you are adjusting. If this has been changed to something other than Opacity: 

Opacity then you may be adjusting a different value. 

Normally you should perform your video edit on Video track 1, and use tracks 2 and 3 for overlays 

and titles. It is a bad habit to edit on multiple tracks. 

Editing tools 

There are eleven tools. They are: 

• Selection tool (V) 

• Track Select tool (A) 

• Ripple Edit tool (B) 

• Rolling Edit tool (N) 

• Rate Stretch tool (X) 

• Razor tool (C) 

• Slip tool (Y) 

• Slide tool (U) 

• Pen tool (P) 

• Hand tool (H) 

• Zoom tool (Z) 

They each have a unique purpose, though the use of some can be achieved by using other tools “the 

long way round” 

To start: 

Selection tool – used to  

Razor tool – Creates a cuts or slices the clip 

Note: when you use the Razor tool to slice a clip, you cannot re-join the clip, but this isn’t really an 

issue, you just drag out the beginning or the end of a clip to refill the sliced off part. 

Select tool 

The Select tool is the most versatile and most commonly used tool. You can use it to: 

• Move a clip around the timeline, including to other tracks 

• Select a clip to perform another action (eg to then delete using the deletion button) 

• Adjust the Connector Line on a clip which could effect the Opacity, Volume or other settings 

• Frome the edge of an existing clip, drag the trim line in to show less of the clip, or drag it out 

to show more of the clip. 

Changing the end point of a clip is adjusting the edit point. 

A basic edit 

Step 1: If their isn’t a clip in the timeline, drag one down onto it. You may want to zoom out so that 

you can see the entire clip on the Timeline. 



Step 2: If there is a gap at the beginning of the Timeline, Right Mouse Button click and choose Ripple 

Delete. 

Step 3: Use the Razor tool to make a slice somewhere on the clip. 

Step 4: Use the Selection tool to select the second half of the clip, and press the delete key. 

Step 5: Hover the mouse over the end of the clip and you will see a Red Bracket with a double ended 

arrow in the centre. Click on the end of the clip and drag to the Right and you will find that you are 

able to expand the clip to its original length. 

You cannot expand the clip beyond its length. When you are at either the beginning or the end of a 

clip you will see a small fold on the top left (beginning) or right (end) of the clip. 

Tools you can find other ways of doing their task 

Hand tool – you use to move the timeline back and forth. Alternatively you can use the scroll bar at 

the bottom of the panel 

Zoom tool – you use to zoom in or (with the Alt key held down) zoom out on the timeline. 

Alternatively you can use the Time Zoom slider at the top of the timeline panel and drag the start or 

end point to adjust zoom. 

Previewing your edit - Monitor 

You have probably noticed that the Monitor window is displaying what is going on in the timeline, at 

the point of the play head. You can drag the playhead back and forth on the timeline, or press the 

spacebar to get a preview. You will notice that the position of the playhead in the monitor and the 

Timeline will match, as you move one, the other will also move. 

The Monitor panel also has a variety of playback features, notable the ability to set an In Point (I) 

and an Out Point (O) and the ability to loop the playback between these points. 

Editing issues 

When you perform this editing, you are not changing the original footage. You have a reference to 

the original footage in your library and the program is showing you what the finished edit would look 

like. Hence this is non-destructive editing. 

If you move the original footage then Premier can no longer find it and the clips in your library panel 

will show that they cannot find the original materials. 



 

This can be a serious problem if you have spent a lot of time putting together a complex edit, and 

the original materials are now gone. 

You can re-link the footage if you get a prompt that the original footage cannot be located: 

 

 



 

Adding transitions 

If you have any cuts in you video at the moment, using the Razor tool, they will be Straight Cut. 

Editing allows you to employ techniques that have been developed for over a hundred years. You 

can experiment with a variety of different editing styles, temporal as well as special cuts, parallel 

edits, contrast and match cuts and jump cuts, etc 

Other ways of cutting involve Dissolves. You can dissolve from the image in one clip to the image in 

another, over a period of time that you choose. Alternatively you can dissolve to a solid colour 

(typically black, sometimes white). A dissolve, particularly to black, carries meaning to the viewer. It 

conveys the passage of time. Dissolves are not used within the one scene. 

Other types of cuts have been developed which involve the movement of an arbitrary shape across 

the screen which controls the transition of one image to the other. This may be a straight horizontal 

line which moves from the top of the screen to the bottom. The line may have a solid edge or be 

soft. These are Wipes. 

To add a default dissolve transition 

Step 1: have an edit in the timeline which contains at least one cut. 

Step 2: place the Play head at the exact point of the cut. The easiest way to do this is with the Page 

Up and/or Page Down keys. 

Step 3: Hold down the Crtl key and press D. 

This will probably apply a Cross Dissolve. 

Notes: You can only apply a transition on two clips who are next to each other in the Timeline. If you 

apply a Transition to the beginning or end of one clip then that clip will transition from to or to black 

(or the clip on a track beneath it), not to the adjacent clip on the time line. 

If you movie one of the two clips after having applied a Transition you will break the Transition 

(typically it disappears, but it may stay on the end of one clip) 

If you Zoom into the Transition you can adjust the length of time the transition takes by dragging the 

Trim edge of the transition. 



Effects 

Transitions are a type of effect, and beyond the simple Cross Dissolve there is a myriad of other 

Transition types. Using multiple different types of transitions does confuse the edit. Ideally you 

should use a straight cut and cross dissolve and if appropriate one other type of transition. 

Despite this ideal, there are dozens of different types of transitions available for use. 

In the Effects panel (Shift 7) there is a group called Video Transitions. Expand this out and you will 

see a number of different categories. Each categories has a number of different Transition Effects. 

You can apply these transition effects by dragging the effect from the Effects Panel to the edit point 

on the Timeline. 

Once you have applied an effect you will want to adjust it. The cross dissolve allows very little 

adjustment, just the length of time the transition runs for. Many others allow some degree of 

adjustment. 

Effects are applied in the timeline (not in the library) to clips. These effects can be used to change 

the image or sound quality, or to change the nature of the clip (the speed or opacity) and to crop the 

image. 

If you are familiar with effects in Adobe Photoshop or other similar image editing software then the 

principals will be familiar for you. Premier adds the extra dimension of allowing the effect to change 

over time (using key frames), as the clip progresses.  

Applying an effect can be very processor intensive, so it may be possible that your computer will 

struggle to render the live image of the clip in the monitor window. Should that be the case you may 

want to look at either: 

• Turning off effects once they have been set 

• Reducing the quality of the monitor window 

Colour Correction 

There is an entire section of Effects tools that are dedicated to Colour Correction. Different problems 

in your footage are resolved using different tools, and some will require a combination of tools. 

In the motorcycle clip provided: 

Step 1: import the clip (if you have not already) and bring the clip into a new sequence 

Step 2: place the play head around the halfway point of the clip. Note that it is quite dark. 

Step 3: from the Effects panel (Shift 7) expand the Color Correction group 

Step 4: apply the Brightness & Contrast effect to the clip by dragging it from the Effects panel to on 

top of the clip. 

Step 5: view the Effects control (Shift 5) panel, and use the flyout on the left of the effect name to 

display the adjustment options for the effect.  



Step 6: Adjust the  Brightness value. 

Effect Controls 

You can see the options available to adjust the effect settings in the Effects control panel (Shift 5). 

Options available vary, depending on the type of effect that you have chosen. Most options should 

be reasonable straight forward.  

You can only see the effects controls if you have the appropriate clip selected in the timeline. If you 

do not have a clip selected, the system does not know what clip you wish to adjust.  

There are three default Video effects for all clips in the time line: Motion, Opacity and Time 

Remapping. 

You can reset an effect to it’s initial values by using the circular arrow icon to the right of the effects 

name. 

To turn off an effect, but still leave the effect present, you unclick the f icon to the left of the effects 

name. This will leave the effect, and it can be reapplied at a later stage, but while turned off will not 

slow down the live render. 

To delete an effect, select its name and press the delete button.  

Effect stacking can have an impact on the way in which it is rendered. The effects are read from the 

top down. 

In this example: 

 

The Blur effect would be applied, then the Timecode written to the screen. The Timecode would 

appear on the screen cleanly. If the order of these two effects is swapped (click and drag) then the 

Timecode would be written to the screen then the Blur would be applied, so it would effect the 

Timecode. 

 



Transition effects control 

 

The Start and End controls indicate where the transition begins and / or ends. You may want to 

transition to end before if has completed its animation. 

Animating effects 

Most effects allow the effect setting to change their values over the running time of the effect. 

If an effect option has a icon of a stopwatch next to it (just to the right of the option name) then you 

are able to animate it. 

Animation works be Keyframes being applied at different points over the length of the clip. At each 

keyframe the value for that option is set. Between the keyframes the value will change. 

For example if you set a keyframe at the beginning of a clip with a value of 0% for the opacity then at 

the end of the clip you added another keyframe for the opacity and set it as 100%, then the clip 

would start out transparent and over the course of the clips running time in the time frame it would 

become solid. Halfway through the clip Premier would calculate an opacity value of 50%. If you 

added another keyframe at the halfway point and set it to have the opacity value of 100% then from 

that point till the end of the clip there would be no change. At a quarter of the way into the clips 

running time, the opacity would now be calculated as 50%. 

You can add as many keyframes as you like, but  

The period between Keyframes is, by default, calculated as straight values. You can change the 

keyframes to be Bezier points by holding down the Ctrl key and clicking and dragging on an existing 

keyframe. This effect of this will be that the values of an option between keyframes is no longer a 

liniar calculation, but will instead  



  

Changes to effects can be seen (and adjusted) in the Timeline, in the yellow Connector line. Only one 

value is visible in the time line at any time. The current value is indicated at the top left of the clip. 

This can be changed by using the drop down options on the effect name.



 

Sound 

Many clips include an audio track. 

The track is normally mono (single channel) or stereo (dual channel). 

When you put a video clip on the timeline in Premier, the accompanying audio track will also be 

included. When you move the clip, the audio track will follow. 

By default a new Sequence in Premier will include three Audio tracks and one Master track. 

When a clip is dragged to the timeline Premier will try and match the Video track number with the 

Audio track number. Premier does distinguish between a Mono and a Stereo clips on the Audio 

tracks of the Timeline. If you drag a clip with a mono soundtrack to video track 1, and audio track 1 is 

stereo then Premier will add a new timeline which is mono, and put the accompanying audio track 

into this new track. 

Master track is used to control the overall volume. The culmination of multiple audio tracks is louder 

than the individual tracks. You do not want the overall volume to be louder than 0db, or you will 

experience distortion. You can see when the volume becomes loud enough to distort by looking at 

the Audio Master Meter (Window > Audio Master Meter). Should the volume exceed the maximum 

or 0db, then peaking will occur. To deal with this you may choose to adjust the volume of individual 

tracks. Alternatively (if you like the mix as it is) you can turn down the master volume. 

You can adjust the volume of any tracks, including the master track by moving the yellow Track: 

volume connector line which is visible on the Audio track of the time line. For individual Audio clips 

you are also able to adjust the volume in the Effects controls (Shift 5) in the Audio Effects section. 

There is the default Volume with the attribute of Level, which can be animated if necessary. 

Un-synchronising the audio and video tracks 

When you move either the Video or the audio part of a clip, the entire clip moves. You are able to 

access the two parts individually in two ways. You can select one without the other by holding down 

the Alt key and selecting either video or the audio component, or you can unlink the two parts. 

Right click on either the video or audio component and one of the options ins Unlink. If you choose 

this then the audio and video component become separate components and can be move and 

edited independently. You can re-link the video and the audio but selecting both components using 

the Shift key, then right mouse button clicking and selecting Link. 

If you move either the video of the audio in the timeline, so that they are no longer synchronised, 

then when you link them again you will see a indication at the beginning of the clip telling you how 

far out of synchronisation the clip is. 

Audio overlap 

When editing your video track, it is very easy for an audio track to be dragged over the top of 

another. You will receive no warning when this occurs. 



To restore any audio that has been removed by this, move the audio part of the clip into a separate 

audio track, then select the audio tack only (using the Alt key), and with the Select tool (v) drag the 

in point or out point back out to restore the missing amount. 

 

 



Exporting video 

You can export the edit you have created in the Timeline by using File > Export (Ctrl M). 

You need to have either the timeline, the monitor window or the item in the library selected, or else 

Premier will not make the assumption on what it is that you want to export. 

You can export a clip directly from the library, which would allow you to export a new instance of the 

clip, but with different attributes (eg smaller frame size). 

When exporting you are able to export the clip directly, or send the export to a queue which can 

contain a number of clips, allowing you to set up a group and export them all at a later time. 

You can export the entire timeline, part of the time line, a still image or just the audio tracks. 

When exporting you can choose form a number of file types. These are independent of the Codec 

used, but different Codecs are available for different file types. Common container types are: 

• QuickTime 

• AVI 

• Ogg 

• MP4 

Compression 

When exporting a clip you have to make decisions on the amount of compression you will use. It is 

very unlikely that you will export an uncompressed clip. They are just too large. As a result you will 

be compressing your clip a certain amount. Most compression is lossy. To compress you will choose 

a different codec. A very common codec at the time of this writing is h.264, which is a derivative of 

the MPEG-4 codec. This codec is one of the standards for High Definition discs like BluRay discs. 

There are other factors involved in making the export size of your movie clip smaller. You could 

reduce the height or width of your clip. if the clip is 1280 x 720 and you halve the width and halve 

the height (640 x 360)  then you will have reduced the clip size to about a quarter of its size. 

Something to consider here is what will your audiences playback medium be. If you know that your 

audience will view the clip via a website, or via a mobile device, then there is no need to produce the 

clip with settings greater than those used by these formats. 

You could also reduce the frame rate. If you have a frame rate of 50fps and you exported your clip at 

25fps then you will have halved the size. 24fps has been a standard rate for analogue systems. 

Modern digital systems are increasing the frame rate to deliver smoother motion, for example in 

2012 The Hobbit was released theatrically and was available in some cinemas at 48fps. Some 

animations run as slowly as 12fps. If size becomes an issue then it is best to experiment with 

different setting to find the best one for your use. 

Step 1: have a basic edit in the timeline of Sequence 01 

Step 2: open the export manager (File > Export > Movie or Ctrl M) 

Step 3:  



 

 

 

Different formats ie YouTube or DVDs 

Premier has bundled a number of presets that allow for export in common formats. 



Adding titles to videos 

Titles are created within the Premier and are treated as assets in the library. 

There are two types of transitions, still and motion titles. Motion menus can either scroll, moving 

from bottom to top, or crawl along the screen from right to left. 

A title exists as an item in the library. You can place a Title on the time line like any other asset, by 

simply dragging and dropping it from the Library onto the appropriate track on the timeline. 

The title is treated a still frame in the time line. Like a still frame you can control the amount of time 

it exists in the time line by dragging the in point or out point of the clip. 

Create a title 

You can create a new title with File > New > Title, or Ctrl T or Right mouse button clicking in the 

library and choosing New Item > title or by using Title > New Title and choosing between Default 

Still, Default roll or Default Crawl. 

You are prompted to name the new title. 

To Edit an existing Title, simply double Left mouse button click on the Title in either the time line or 

the library. 

When creating or editing a title you are taken to the Title Designer interface: 

  

Most aspects of this interface are to do with text. The Panels in this window are: 



• Title tools (Top Left) 

• Title Actions (bottom Left) 

• Title Styles (Bottom Centre) 

• Title Properties (Right) 

Title Tools allow you to create the text of your title, as well as some shapes. You are able to draw a 

line using the Pen tools and place text upon it using the Path Type Tool and Vertical Path Tool. There 

are also some basic shapes. 

The three typing options (Type Tool, Area Type Tool and Path Type Tool) also come in Vertical 

variations. 

You also have two tools to Select (v) and Rotate (o) the objects in the title 

Title Actions allow you exact control over alignment and distribution of the title objects. 

Title Styles provide dozens of predefined font colour, face, size and effect options. You are able to 

save any combination that you create with the Title Styles flyout menu (black triangle in the top right 

corner of the panel) and choosing New Style while the text is selected. 

Title Properties give the ability to adjust the Position, size and Opacity (Transform), Font options like 

Family size and Kerning, etc (Properties), Colour, opacity and options for gradients or patterns of the 

Text (Fill), Outlines (Strokes) and Drop shadows (Shadow). 

Along the Top Centre of the Title Designer are some of the main tools. Here you can choose to: 

• Animate a Title 

• Use a Template 

• Set alignment 

• Tabs stops 

• Control whether to show the timeline behind the Title designer (may be confusing, but 

useful to preview) as well as advancing the point on the time line displayed. 

Title Roll Crawl options 

Bearing in mind that the title is treated as a still 

object in the time line, you can still animate it. It 

becomes important to consider the relationship 

of the amount of time you allow the title on the 

time line to the speed of the motion in a Rolling 

or Crawling title. 

The two types of animated title are rolling (such 

as used at the end of feature films) or crawling 

(as is often used for updates on a news bulletin). 

A crawling menu can move from left to right or 

right to left. 

There are six options: 



Start Off Screen / End Off Screen check boxes, 

• Preroll – still before movement 

• Ease-In – slows acceleration at beginning 

• Ease-Out – slow deceleration at end 

• Postroll - still after movement 

the four text fields are measured in frames. 

Title Speed Control 

The speed at which a motion title moves is controlled by the amount of time if has to run on the 

time line. If you had ten lines of text and allowed two seconds at 24fps (so 48frames), then each line 

would be moving at 4.8 frames per line. If you extended the duration on the timeline to ten seconds 

(240 frames)then the text would be moving at a leisurely 24 frames per line. 

Any values that you add to the Timing options tend to reduce the amount of time that the title text 

itself has to be on screen. For example, consider if you place your title on the time line for a total of 

five seconds (at 24fps, so 120frames), if you allowed the titles to start and end off screen that may 

take away more than 20 frames, if you have a Postroll of 24 (frames) then you reduce the time that 

the title have to run by a further 24, so we may be down to 76 frames from the original 120, 

requiring the text to move at almost twice the original rate. 

 



Interact dynamically with other Adobe applications 

Increasingly with each new version of the software, Adobe has been allowing integration between 

their products. The three that Premier does the best work with are Photoshop the Image editing 

software, Encore the DVD mastering software and After Effects which can be used for Animation, 

Visual Effects and Motion Graphics. Using markers in the time line can be interpreted by Encore as 

chapter stops. Premier can very easily move back and forth for more complex image adjustment in 

After Effects. Audio files (or the audio component of video files) can be edited in Soundbooth or 

Audition. Image files in the library and in the time line offer the option (with a right mouse button 

click) to edit the file in Photoshop. When you have closed the file in Photoshop you are returned to 

Premier. 

Photoshop files (.psd) natively support multiple layers including transparency (Alpha) layers. 

When importing into Premier you have the ability to import a Photoshop file as individual layers or 

as a flattened file. These layers will preserve any alpha channels. 

Step 1: import into the library from the media provided still/overlay-week-02a.psd (or b or c) 

Step 2: when prompted 

Step 3: also import Basil.mp4 and Oscar.mp4 

Step 4: drag Basil into Video track 1, Oscar into video track 3 and overlay into Video track 3. Note 

that Video track 3 has transparencies, allowing you to see through onto the track below 

Step 5: Use the Position and Scale settings (under Motion in the Video Effects sections of the Effects 

Controls) to place the two clips where you like them. 

Step 6: if necessary apply the Crop effect to video track 2, and adjust using the effects Controls. 

Preview your work, add a title if you like. 
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